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Introduction

A database program, such as Microsoft Access, is a program that stores and retrieves “records” of information.  For example, all of your student information such as names, addresses, telephone numbers, etc. are stored as one or more records in a database here at DePaul.  More than likely, there are numerous databases here on campus, each one storing different kinds of data pertaining to the day-to-day operations of the university.  Local, state, and federal governments also maintain many different types of databases.  When you go to the Secretary of State’s office to renew your driver’s license, they retrieve your records from one of their databases.  When you submit your federal taxes each April 15th, all that information from the 1040 form is stored in one or more federal databases.

Information such as Last Name, First Name, Street Address, and City are considered fields.  A collection of fields or information about a particular instance of a subject is called a record.  A collection of records is called a table.  For example, if we collect name, address and telephone numbers for a home address book, it might look something like the following table:
Name

Address
Telephone

Abbott, Sue
123 Main
555-1212

Jones, Steve
234 Oak
555-2266

Miller, Jackie
345 Pine
555-4422

Smith, Stan
456 Elm
555-0212
Name, Address, and Telephone are the fields.  The first record contains the data Abbott, Sue   123 Main   555-1212.  All four records taken together create a table.

Let’s enter the above table into Microsoft Access.  On your computer: Run -> Microsoft Access.  Under Open, Create a new file… then click on Blank database… and enter a name for your database (or use the default name that Access is suggesting).  You should then see the following screen:
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The first thing you need to do is create a table, so Access automatically highlights Tables in the left hand column.  The best way to create a table is in Design view, so double-click on this.  You should now have something that looks like the following:
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Now under Field Name you can enter Name.  For the Data Type, leave it as it is as Text.  

There are actually several options for the Data Type.  The most common (and the default, as you just saw) is Text.  All letters and numbers (and pretty much everything else you can type on the keyboard) can be entered as Text.  You can also define the field to be Number.  You should only make a field Number if you plan on doing arithmetic with it.  For example, if you are going to store student GPAs, then make the field Number, since later on you may want to calculate the average GPA.  But if you are going to store telephone numbers, do not make the field Number.  Are you ever going to add two telephone numbers together?  (That doesn’t even make sense.)  By defining a field to be Number, you are making the computer do extra work.  If you really do want the field to be Number, do you want decimal places or not?  If you want decimal places, then make the Number’s Field Size (in the menu on the bottom left) Single or Double.  If you don’t need decimal places, make the Number’s Field Size Integer or Long Integer.
Other field types include Date/Time, Currency, and Yes/No (for fields that have only two possible values – yes or no).  You can also create a field type called Autonumber.  If you select Autonumber, it is essentially the same as a number field of size integer.  But you won’t enter data into an Autonumber field.  Access will automatically enter values for you, starting with the integer 1 and continuing with 2, 3, etc.  Autonumber is often a good field type if you want to define your own primary key and want Access to simply enter the values 1, 2, 3 and so on.
If you enter our sample three fields (from above) Name, Address, and Telephone, the table definition should look like the following:
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Let’s close this table definition.  When you close this window, Access asks you if you want to save the changes to this table.  Answer Yes.  It then asks you for a name for this table.  Pick a table name that is descriptive of what it is being used for.  We’ll pick the name Address Book.  Next, Access reminds you that no primary key was defined for this table.  Do you want Access to create a primary key for you?  If you enter Yes, Access will add another field to your table and define this field as the primary key.  If you answer No, then you can either skip creating a primary key or you can go back into the table definition and define your own primary.  Before we answer either way, what is a primary key?
The Primary Key

A primary key is typically a field in a table that will never have duplicate entries.  For example, if you were to define the field Last Name as the primary key and then later on added two people, both with the name SMITH, you would have an error condition.  You could only define Last Name to be a primary key if that field never has two entries with the same name.  If instead you created a field such as Customer ID or Employee ID or even Social Security Number (which you really shouldn’t do because of privacy issues) you could define any one of these fields as a primary key.  That is, the reason you are giving all of your employees an ID is such that each employee has an ID number that is unique to only that employee.
Does each table need a primary key?  No.  There are reasons for having a primary key just as there might be reasons for not having a primary key.  Normally, however, it is a good idea to identify one field as the primary key.  Consider our previous example of the Address Book.  The table had three fields: Name, Address, and Telephone.  Can any one of these fields be a primary key?  What about Name?  As we just saw, only if no two names are identical.  This is probably not a good choice for the primary key.  What about Address?  Here again, you might have two friends living at the same address, thus you would have two entries with the same value.  This is also not a good choice for a primary key.  What about the telephone number?  This might be a possible choice for a primary key.  We tend to associate a telephone number with an individual, family, or business.  But if you prefer, we could always create a fourth field, such as ID, and create a simple ID number for each entry in our table.  Thus, we might have a friend named Smith that lives at 123 Main Street with the telephone number 555-1212 and with an ID of 001 that we assigned.

Let’s say we want to go back into our Address Book table and define the Telephone field as a primary key.  Click once on the table name Address Book and then click on the Design button (just to the upper left).  This will open the table Address Book in design mode.  Highlight the field Telephone by clicking in the little box to the left of the field name Telephone (this will highlight the entire field entry).  Then from the top menu bar click on the little golden key.  (You can also right click in the little box to the left of the field name Telephone and select Primary Key from the list of options.)  This will now place a key next to the field name Telephone, thus making Telephone the primary key.  Just remember – now you cannot enter two names into your address book with the same telephone number. 

Multiple Tables
Rarely do we place all the data into a single table.  In fact, many large databases consist of hundreds, even thousands of tables.  As a simple example of this, let’s go back to the student database here at DePaul.  What if DePaul wants to record all the basic information about each student (name, address, telephone number, etc.) as well as each course taken each quarter?  A beginner, not versed in proper database design, might create a table like the following:
Student ID (primary key)
Last Name

First Name

Street Address

City

State

Zip

Home Phone


Following fields repeat 1-n times:

Course Name


Quarter



Year



Grade

But this is poorly designed.  What if a student has taken 40 courses?  Do we define 40 sets of fields with the last one named Course Name40, Quarter40, Year40, and Grade40?  What if a student then continues taking classes and has 50 classes?  Are we supposed to go back into the database design and add ten more sets of these fields?  No, that would be a terrible way to design a database.

What we need to do is to create two tables.  The first table would contain the basic student information, such as Student ID, Last Name, First Name, Street Address, City, State, Zip and Home Phone.  
Then in a separate table we create the following fields:


Course Name


Quarter

Year

Grade


Student ID

Note that along with the course and grade information, we have included the Student ID.  We have to include the Student ID so that we know which student record this grade record relates to.  We can’t just have a bunch of grade records without knowing who they belong to.
So if we have a student record that begins like this:

Student ID=299181
Last Name=Jones
…

We might have a couple grade records that look like this:

Course Name=HST 101
Quarter=Spring
Year=2005
Grade=B+
Student ID=299181

Course Name=MAT 210
Quarter=Spring
Year=2005
Grade=A-
Student ID=299181

In the first table, the Student ID is the Primary Key.  But in the second table, Student ID cannot be the Primary Key, because as we just saw, there are two grade records with the same Student ID.  This would violate the rule of a Primary Key.  But we have to bring the Primary Key over from the first table and insert it into the second table to provide a relationship.  When we bring the primary key over to the second table, it becomes the foreign key.  Microsoft Access has no way of formally specifying a foreign key, so we’ll just note it in our head.

When you remove repeating fields from a table and use them to create a new table (along with a foreign key), this is called converting the data into first normal form, or simply normalization.

Relationships

Let’s talk about relationships a little more before we take a look at another example.  As we just saw, we had two tables: the first table contained basic student information and the second table contained student grade information.  We made a connection between the two tables using the student ID.  Thus, there is a relationship between the two tables.  This is the basis for this field of study called relational databases.  Most databases (if properly designed) consist of multiple tables with relationships between the tables.

When we created the two tables above and had the field Student ID in both tables with Student ID in the first table as a primary key (and both Student IDs with the same data type), Access automatically created a relationship between the two tables.  When we view the two tables in a query (more on queries shortly), we get something that looks like this:
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Notice the line between the two Student IDs.  Access has created a default relationship for us.  If we want to create a permanent relationship, go to the Tools drop-down menu and select Relationships.  Add both tables to the view.  Then click on Student ID in one table and drag it over to the Student ID in the second table and un-click.  You should get a box like this:
[image: image5.png]Edit Relationships

Tablejuery: Related TablefQuery:

[Eaforce Referenta ntearty) [create iew. ]

Relationship Type:  One-To-Hany





For now, just click on the Enforce Referential Integrity box.  Why?  Think of the Basic Student Info table as the parent and the Grade Info table as the child.  By checking this box, we cannot have child records without a corresponding parent record.  Hit the Create button and then close the Relationships window, saving the results.  You now have a permanent relationship between the two tables (which of course can be deleted later if you change your mind).
Let’s consider a second example.  Let’s say we are trying to maintain a database for season ticket holders for our college basketball team.  We would probably need information, like the following:

Last name (of season ticket holder)

First name


Address


City


State


Zip


Phone


Following fields repeat 1-n times:



Section number

Row number

Seat number

We obviously need to repeat the section, row, and seat number multiple times because one person might have 2, 20 or even 50 season tickets (like a big corporation).  So that we can leave the number of season tickets open, let’s normalize this database and move those fields to a separate table.  While we’re at it, let’s add a primary key to the first table.  Here are the results:
Table 1



Table 2

Customer ID (primary key) 

Section number
Last name



Row number
First name



Seat number
Address



Customer ID (foreign key)
City






State

Zip

Phone

Don’t forget that the Customer ID in Table 1 should be the same type (probably Text) as the Customer ID in Table 2, or there won’t be a relationship created automatically by Access.
Performing Queries

Now that we have created the tables and entered the data into our database, let’s see how to pull the data back out.  More specifically, we want to learn how to perform a query.  A query allows us to extract only that data in which we are interested.

For example, from our season ticket holder database, we might want to find out what seats Sue Smith has.  Or maybe we know a section number, row number and seat number and wish to find out who is sitting in that seat (if anyone).  Queries allow us to do that.

To perform a query, select the Query tab on the left side of the Access window.
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Let’s create a query in Design view using our Season Ticket Holder example.  If you click on “Create query in Design view”, you will get the following window inside a larger window:
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Let’s say we want to view Sue Smith’s seats.  To do this, we will access the following fields: Last name and First name (for Smith, Sue) and the seat information (Section number, Row number, and Seat Number).  These fields are in two tables – the Customer Info table and the Seat Info table.  Thus, we need to Add both of these tables to our query.  So click on and then Add both tables to the query.  When they are added, click on the Close button.  You should then have a screen that looks something like this:
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We want to show Sue Smith’s seats, so in the Customer info box, double click on Last name, then double-click on First name.  Then in the Seat info box, double-click on Section number, Row number, and finally Seat number.  The query should now look like the following:
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Since we are asking for Sue Smith’s seats, in the Criteria box under Last name, enter Smith (case sensitive), and in the Criteria box under First name, enter Sue.  We are now ready to run the query.  Simply click on the red exclamation mark.  You should get the following screen:
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While it doesn’t look all that pretty, we clearly see Sue Smith’s four seats.

While in the Query Design view, you can perform a query on any and all fields.  If you are looking for people in a particular city, you can bring down the City field and then in the Criteria box enter the city you are looking for.  If you are looking for season ticket holders in two different cities, you can enter the first city name, and then in the box below it – the “or” box – you can enter the second city name.  Access will then search for all ticket holders in either city.  What if you are looking for the person holding the seat in section number J, row 5, and seat 12?  Create a query in which the Section number criteria is J, the Row number criteria is 5, and the Seat number criteria is 12.  If you are also showing Last name and First name, your answer will appear when you run the query.
In the query boxes you can also perform logical ANDs and logical ORs.  If the values of the types are Number, Currency, or Date/Time, you can also use <, >, <=, >=, <> (not equal), and BETWEEN (if you are looking for the values from 1 to 5 you can say BETWEEN 1 and 5).  You can also use the criteria IN.  For example, if you are looking for someone living in either Illinois, Indiana, or Michigan, you can say IN (“IL”, “IN”, “MI”).
More Advanced Queries

You can also create queries which calculate totals and averages.  For example, let’s use a database which holds the records of a pet veterinarian.  The Customer Info table looks like the following:
	Customer Info

	Customer ID
	Customer Last Name
	Customer First Name
	Address
	City
	State
	Zip
	Home Phone

	12345
	Smith
	Sue
	123 Oak
	Forest Park
	IL
	60312
	708 555-2111

	23456
	Jones
	Bill
	234 Elm
	Burr Ridge
	IL
	60544
	847 333-9292

	34567
	Kingsfield
	Prof
	345 Pine
	Chicago
	IL
	60604
	312 999-2828

	45678
	Hart
	James
	5399 Salem
	Addison
	IL
	60433
	773 220-1919

	56789
	Ford
	Franklin
	12 Regency
	Wilmette
	IL
	61221
	847 322-5353

	67890
	Bell
	Robert
	3348 Willow
	LaGrange
	IL
	63220
	847 332-1942


The Pet table looks like the following:
	Pet

	Pet ID
	Type of Animal
	Pet Name
	Breed
	Color
	Weight
	Height
	Customer ID

	11111
	Dog
	Snickers
	Mutt
	Brown
	23
	28
	12345

	11112
	Cat
	Whiskers
	Tiger
	Orange
	8
	11
	12345

	11113
	Dog
	Jo-Jo
	Great Dane
	Brown
	73
	39
	23456

	11114
	Dog
	Clancy
	Cockapoo
	Black
	22
	19
	34567

	11115
	Bird
	Tweety
	Canary
	Yellow
	0.1
	4
	45678

	11116
	Dog
	Murphy
	Rock Hound
	Red
	28
	41
	45678

	11117
	Snake
	Viper
	California King
	Black
	0.2
	1
	45678

	11118
	Dog
	Arthur
	Mutt
	White Black
	12
	18
	56789

	11119
	Cat
	Henry
	Wild
	Orange
	17
	12
	67890


Suppose we want to count the number of dogs that this vet has as patients.  We could form a query like the following (selecting only the fields from the Pet table):
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Notice that we have created a query using the Pet table.  In the query, we have included the Field Type of Animal twice.  Also, we have clicked on the Totals symbol which includes a new row in the query design: Total.

In the first instance of Type of Animal, in the Total box we change Total to Group By.  We also enter “dog” in the Criteria box.  In the second instance of Type of Animal, we change total to Count.   Do not enter the criteria of “dog” in under the Count column.  When we run the query, we get the following results:

	Query1

	Type of Animal
	CountOfType of Animal

	Dog
	5


We have grouped the pets by “dog”, and then counted how many.

What if we want to compute the average weight and height of all the pets.  Our query would look like this:
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The results would look like this:

	Query1

	AvgOfWeight
	AvgOfHeight

	20.3666666671634
	19.2222222222222


What if we wanted to compute the average weight and height of all dogs.  Simply modify the above query to include a third field with Type of Animal and Criteria “dog”.
Finally, what if we wanted to find the average weight and height of all the groups of pets? In other word, the average weight and height of all dogs, average weight and height of all cats, etc.  Simply perform the same query as the previous one but do not include “dog” under the criteria.  If you simply Group By Type of Animal, you should get the following:

	Query1

	AvgOfWeight
	AvgOfHeight
	Type of Animal

	0.100000001490116
	4
	Bird

	12.5
	11.5
	Cat

	31.6
	29
	Dog

	0.200000002980232
	1
	Snake


Access Forms

An Access form is a nice way to view and update or enter data into an Access database.   To create a form, go to the main Access screen and click on the Forms tab on the left side in the Objects window.  You can make a pretty decent form by using the Wizard, so click on Create form by using wizard.  The wizard is pretty self-explanatory.  You will first have to answer which Table or Query you want this form to work with.  Once you have selected the table or query, you must decide which fields you want to put on the form.  If you want all fields, click on the double arrow (>>).  On the following screens you select the form layout, form style, and title for your form.  After you click on Finish, Access will show you your form.  If you want to tweak your form, go to View -> Design View.  You are now looking at the form in design view and it might look something like the following:
[image: image13.png]Microsoft Access - [Listings : Form] [-)EX]

on for help

€ Form





At this point you can click and drag any of the boxes (they are called controls) to any point on the Detail that you like.  You can remove controls by clicking on the control box and then pressing the Delete key.  You can also add new controls.  Click on the pulldown item View and then select Field List.  Field List contains the names of the fields from the table you are using for your form.  If you didn’t include all your fields in your form when you were creating the form via the wizard, you can now bring a field in.  For example, let’s delete the State control from your form.  Click on the State control box and hit Delete.  Now, go to the Tools window and click on the symbol ab|.  Then click and drag the field name State from the Field List over to your design.  When you release the mouse button Access will drop a State control box at that point.  
What if you have a field that has only a Yes/No value?  It might be cool to represent that field on the form with a Check Box or Option Button.  Click on either the Check Box or the Option Button in the Tools window, then click and drag the appropriate Yes/No field to the design.  You can also include Toggle Buttons, Combo Boxes, and List Boxes in the same fashion.  You can insert images or pictures onto your design if you want to embellish your form.


When you are satisfied with your form design, click on View -> Form View to look at your form.  Notice you can scroll through the records by clicking on the advance buttons on the bottom left of your screen.  If you want to add a new record, simply advance to the last record and then advance one more time.  You should now see your form with empty fields.  If you enter data, this data will be stored in your database.

Access Reports

What happens if one day your boss walks into your office and says she wants you to create a printed report.  In this report, she wants a listing of each employee and how much they have spent so far this year on travel expenses.  Furthermore, she wants the list to be grouped by the departments within the company, and within each department she wants the employees listed alphabetically.  At the end of each department she wants a total of expenses, and at the end of the report a grand total of all expenses.  You tell her that you are pretty busy and that a report like this might take some time.  She says OK and to get it to her within a week.  She leaves and you turn to Access.
In Access, click on Reports in the objects window, then click on Create report by using wizard.  You will use the table with the employee data, then select the fields Department, Name, and Expenses.  When you click on Next, Access asks you if you want to add any grouping levels.  Recall that the boss wanted you to group the employees by Department, so click on Department and copy it to the right side of the window.  That is the only grouping level you want, so click on Next.  Access then asks you what sort order you want within the Department groupings.  You want to alphabetize the employee names, so click on the little blue down arrow and select Name.  Ascending order is what you want, so click on Summary Options next.
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Your boss wanted you to Sum the Expenses for each Department and for the final summary, so check the box under Sum and then click on Detail and Summary in the Show section, followed by OK.  Now that you are back on the sort order and summary information page, click Next.  Select the Stepped Outline, select a style, pick a name for this report, and finally click on Finish.  Access will now show you the report.
If you don’t like the way the report looks (if some fields are truncated or spacing is strange), click on View -> Design View.  Just like when working with a Form, the Report Design view allows you to move controls around and resize them.

When you finish changing the report, you should get something that looks like the following:
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